# Table of Contents

Indications for Use Statement ........................................................................................................... 2  
Software License Agreement (revised 2014-10-29) ......................................................................... 3  
  Important ........................................................................................................................................ 3  
  Regulatory ....................................................................................................................................... 3  
  Appropriate Usage .......................................................................................................................... 3  
Ownership ........................................................................................................................................ 3  
Grant of License ............................................................................................................................... 3  
Access to Updates ............................................................................................................................. 4  
Restrictions ....................................................................................................................................... 4  
Termination ...................................................................................................................................... 4  
Rights .............................................................................................................................................. 4  
Limited Warranty (Software) ............................................................................................................ 5  
BIA Test Protocol ............................................................................................................................. 6  
Software Installation ........................................................................................................................ 7  
Launching BC ................................................................................................................................... 8  
Opening a Database .......................................................................................................................... 9  
Remembering the Last Database ...................................................................................................... 9  
Selecting a Person – The Person List ............................................................................................... 10  
Searching the Database by Date ...................................................................................................... 11  
The Person Identification Window ................................................................................................... 11  
Entering Test Data ............................................................................................................................. 11  
Test Results ..................................................................................................................................... 13  
Creating Reports ............................................................................................................................. 13  
The Test List .................................................................................................................................... 14  
Pre-filling Follow-Up Tests ............................................................................................................. 14  
Changing Equations ........................................................................................................................ 15  
Report Options ............................................................................................................................... 16  
"Quick Report" Templates ............................................................................................................... 17  
Exporting Data ............................................................................................................................... 18  
Configuring Communications .......................................................................................................... 19  
Analyzer Maintenance ....................................................................................................................... 20  
Expanded Topics .............................................................................................................................. 21  
  Activity Level ............................................................................................................................... 21  
  Body Mass Index (BMI) ............................................................................................................... 22  
  Electrodes ....................................................................................................................................... 23  
  Electronic Medical Implants ......................................................................................................... 23  
  Frame Size ..................................................................................................................................... 24  
  Re-installation ............................................................................................................................... 24  
  Statistical Analysis ....................................................................................................................... 25  
  Calculating a Target Weight ......................................................................................................... 25  
    Hamwi Ideal Weight Equation .................................................................................................... 25  
    Target Weight Based on Target BMI ......................................................................................... 25  
Glossary of Terms .............................................................................................................................. 26
Indications for Use Statement

Calculation and Historical Tracking of:

- Actual Whole-Body Impedance
- Actual Whole-Body Phase Angle (PA)
- Estimated Whole-Body Fat (FAT)
- Estimated Whole-Body Lean Soft Tissue (LST)
- Estimated Whole-Body Bone Mineral (BMC)
- Actual Segmental Impedance
- Actual Segmental Phase Angle (PA)
- Estimated Segmental Fat (FAT)
- Estimated Segmental Lean Soft Tissue (LST)

Intended Population:
BC is intended only for use on normally healthy adults and adolescents age 3-94. It is not intended to be used to diagnose, prevent, treat, or cure any disease or medical condition.

Contraindications:
No known contraindications exist.

Warnings:
- The BC software provides body composition estimates based on the electrical characteristics measured by a Bioelectrical Impedance Analyzer (BIA). BIA technology introduces an alternating current (AC) signal into the body, and then measures how that signal is affected by the body. In keeping with FDA statements about the lack of studies done by electronic medical device implant manufacturers (i.e. pacemaker, defibrillator) regarding the safety of BIA with their devices, RJL Systems warns against the use of BIA on an individual with an implanted electronic device.

- BIA should not be utilized on individuals with abnormal heart rhythms, during electrocardiograms, or on individuals connected to life-support electrical systems.

- Women who use this device should not be pregnant or suspected of being pregnant. Besides increased inaccuracy of readings in this condition, the effects of measurement on the fetus are unknown.

- Prediction equations used by the BC software assume there has not been an arm or leg amputation. In the case of active prostheses on the right side of the body, affecting standard electrode placement, the Practitioner may choose to test the left side of the body. In this case, individual tests can only be compared to subsequent tests on that individual, noting the average population ranges and prediction equations would likely not be relevant.

Precautions:
Using the BC software to evaluate individuals outside of the above intended population, or failing to follow the individual preparation and testing procedures detailed in the documentation for your Bio-electrical Impedance Analyzer could adversely affect the body composition assessment provided by this application.

RJL Systems BC software is intended for “Over-the-Counter” distribution.
Software License Agreement
(revised 2014-10-29)

Important
By using this software you accept the following terms of this License Agreement. If you do not agree with these terms, you should not use the software and promptly return it for a refund.

Regulatory
This software is regulated in many countries as a medical device. As such, your country’s government may require RJL Systems to obtain certain registrations or licenses from them, or they may mandate that the software and documentation be available in a specific language before you may legally obtain or use this software. They may also impose other requirements and conditions. Unless you are in one of the following countries, please DO NOT install this software without first contacting RJL Systems for guidance:

• The United States of America
• Canada

Appropriate Usage
The Indications for Use and Intended Use statement can be found in the software’s User’s Guide, and describes:

• what the software does,
• on what populations or groups of people it should (or should not) be used,
• and for what purposes the software and any information it produces should (or should not) be used.

Any use not described therein should be considered “off-label” and is hereby expressly disclaimed. This statement may also be found on the RJL Systems website.

Ownership
RJL Systems retains the ownership of this copy of the enclosed software package. It is licensed to you for use under the conditions outlined in this agreement.

Grant of License
You may only concurrently install the enclosed software on the number of computers for which this license grants. Most license keys will only permit the software to be used on one computer. If the license key allows for multiple installations, the total number of allowed concurrent installations will be noted on your invoice.

An organization may have multiple licenses for the enclosed software, each allowing the installation of one or more copies. These copies may all interact with the same body of data, even if they are covered by different licenses.
Access to Updates

In addition, your license key grants you subscription access to any and all updated releases of the software for a period of 1 year (12 months) from the date of issue. The subscription period may be extended for an additional fee. If the subscription is allowed to lapse, any copies of software which have been installed and successfully activated will continue to operate normally.

HOWEVER: Any copy of the software that was released after your subscription has lapsed will either refuse to function or will function as an unlicensed trial copy of the software until and unless your Updates Subscription is renewed. This includes releases that are used to upgrade an existing working installation.

Restrictions

Unless you have received specific, prior, written approval from RJL Systems:

- You may not copy the documentation or software except as described in the installation section of this manual.
- You may not distribute, rent, sub-license or lease the software or documentation, including translating, decompiling, disassembling, or creating derivative works.
- You may not reverse-engineer any part of this software, or produce any derivative work.
- You may not make telecommunication transmittal of this software.

Termination

This license and your right to use this software automatically terminates if you fail to comply with any provision of this license agreement.

Rights

RJL Systems retains all rights not expressly granted. Nothing in this license agreement constitutes a waiver of RJL Systems’ rights under the U.S. copyright laws or any other Federal, State, or international law.
Limited Warranty (Software)

If you received this software on physical media (eg: CDROM or USB drive) and it suffers a defect that prevents its installation, RJL Systems will it at no charge to you, provided you return the item to be replaced with proof of payment to RJL Systems during the 90-day period after having taken delivery of the software.

RJL Systems, Inc. excludes any and all implied warranties, including warranties of merchantability and fitness for a particular purpose and limits your remedy to return the software and documentation to RJL Systems for replacement.

Although RJL Systems has tested the software and reviewed the documentation, RJL SYSTEMS MAKES NO WARRANTY OF REPRESENTATION, EITHER EXPRESSED OR IMPLIED, WITH RESPECT TO THIS SOFTWARE OR DOCUMENTATION, ITS QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, THIS SOFTWARE AND DOCUMENTATION ARE LICENSED “AS IS” AND YOU, THE LICENSEE, ARE ASSUMING THE ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE.

IN NO EVENT WILL RJL SYSTEMS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE OR DOCUMENTATION, even if advised of the possibility of such damages. In particular, RJL Systems, Inc. shall have no liability for any data stored or processed with this software, including the costs of recovering such data.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESSED OR IMPLIED. No RJL Systems, inc. dealer, agent, or employee is authorized to make any modifications or additions to this warranty.

Information in this document is subject to change without notice and does not represent a commitment on the part of RJL Systems, Inc. The software described in this document is furnished under this license agreement. The software may be used or copied only in accordance with the terms of the agreement. It is against the law to copy the software on any medium except as specifically allowed in the license agreement.

No part of this manual may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, for any purpose without the written permission of RJL Systems, Inc.

Some states or countries do not allow the exclusion of implied warranties or liability for incidental or consequential damages, so the above limitation or exclusion may not apply to you. This warrant gives you specific legal rights, and you may also have other rights, which vary, from state to state.
BIA Test Protocol
For best results, RJL Systems recommends that the following preparation and administration conditions be met:

- No alcohol within 12 hours of the test.
- No caffeine (i.e. coffee, tea, ‘energy’ drinks, soda pop) within 8 hours of the test.
- Height, weight, age, and gender are accurately recorded.
- All electrode sites will be cleaned with alcohol and allowed to dry, prior to electrode placement.
- Specified red and black leads need to be attached in the correct and standardized manner (‘top or bottom placement’), as illustrated (see below).
- The right shoe and sock or nylon stocking, as well as any other objects in the way of proper electrode placement must be removed from the body.
- During the test, the individual will lie supine, quietly without moving, with arms 30 degrees from the body, and legs not touching each other. Consider a fabric pillow between the legs if necessary.
- No exercise or sauna within 8 hours of the test.
- Metal and/or magnetic jewelry, therapeutic magnets, communication devices, cellphones should be removed from the body.
- The attached in a precise and standardized manner, as illustrated (see below).
- To prevent damage, do not press too heavily on the electrode sites. Exert only enough pressure to ensure proper adhesion.
- Electrodes are to be discarded after one use.

Electrodes are placed in identical locations on the left hand and foot.

**Practitioners must demonstrate the following level of proficiency before administering a BIA test:**
Make two consecutive sets of Resistance and Reactance measurements on a single stable individual, using new electrodes for each measurement. There must be less than one percent (1%) variance. If multiple practitioners will be administering BIA tests, they must also demonstrate less than 1% variance between practitioners.
Software Installation

Your RJL Body Composition Software will run on both a Windows PC and a Macintosh computer. The system requirements are as follows:

**PC**
- Windows XP or newer
- 32 MB of RAM
- 32 MB of disk space (plus space for the databases)
- Standard USB Port (for installation)

**Macintosh**
- Snow Leopard (OS X 10.6) or newer
- 32 MB of RAM
- 32 MB of disk space (plus space for the databases)
- Standard USB Port (for installation)

To install BC, you must be logged into the computer using an administrator-privileged account.

Once the RJL Systems thumb drive has been inserted, your computer should either automatically start the setup program (or ask for permission to start the setup) or it should show you the contents of the drive. If you are shown the disk contents, double-click the icon for the appropriate setup wizard. (either setup-windows or setup-osx)

Your computer may ask you for permission or a password to start the setup wizard. Once it is running, you will see the following screens in the wizard:

1) **Welcome** – Just click **Next**.

2) **License** – You must accept the license agreement before you can continue. Click **Enter**.

3) **Component Selection** – This screen provides the following options:
   1. Install BC – This option will (re)install the Body composition software on your computer.
   2. Communication Device Drivers – Some RJL analyzers have either a USB or a 9-pin serial port which allows them to communicate with software on your computer. If your analyzer has a communication port, in order to use it, your computer must have certain device drivers installed. Installing the drivers is safe even if your analyzer does not have a communication port, so you can safely leave this selected regardless.
   3. Register Warranty – Leave this selected to submit warranty registration electronically.
   4. Install User Manuals and Documentation – Select this to copy the user guides for each of the RJL Systems analyzers and software to your computer. It is recommended that you leave this option active. The user guides do not occupy much space on your computer. If installed, they can be accessed from the “Help” menu of the program.

4) **Installation Directory** – Tell setup where to install the program. Most people will simply accept the default.

5) **Warranty Contact Information** – If you told setup to register the warranty, this screen will ask for the contact information for the person using and/or managing the RJL products. While all of the information is important, please be sure to at least provide an email address and leave the “Send me news of updates” box checked. This will ensure that if an update to BC is released, or if there is important news about any of your RJL products, you will stay informed.
6) **Warranty Product Information** – Tell us about your RJL products, where you purchased them, and when.

7) **Ready** – Just click **Next**.

8) **Installing** – This is where setup does its work. If you told setup to install the communication drivers, you may see extra windows appear briefly, or a new installer wizard may ask for permission to install them.

9) **Finished** – When you get to this screen, setup is done.

**Launching BC**

The icon to launch BC will be listed under “RJL Systems” in the Applications list on OSX, or “All Programs” in the Start Menu in Windows. The Windows setup wizard will also put a shortcut on your desktop.

If this is your first time working with BC or you instructed BC to not automatically reopen the last database that was used, you will see the “Welcome” screen, which explains how to get started.
Opening a Database

To open or create a database in BC Segmental, select "Open or Create Database" from the File menu.

If you have previously opened a database in BC Segmental, the folder containing that database will be opened in the file-chooser by default. If not, the current practitioner's documents folder is likely to be the one shown.

To create a new database, start by choosing a place to store it. If more than one person will be logging into the computer to use BC or if you have a file server on the network that is backed-up on a regular basis, you might want to change this location. Otherwise, the documents folder is probably a good choice.

Once you are satisfied with where your database is going to be saved, you have to decide what to call it. RJL Systems recommends that you choose something generic, like "Body Composition Data". For the most part, it is a good idea to only create one database to hold all of your individual data, unless you have a very good reason to keep one group of people separate from another. If you choose to create more than one database, you will need to be careful that you always make sure that you have the correct one open before you start entering data – this prevents having an individual’s test history from being spread across multiple databases.

After giving your new database a name, click Save. BC will ask to confirm that you really want to create a new database.

If you want to reopen an existing BC Segmental database, find it, select it, and then click the Save button. If you already have a database open, BC will ask to confirm that you really want to change to a different one.

Remembering the Last Database

By default, when you close and reopen BC, it will automatically reopen the last database that was used. If you only have one database with individual data, this feature allows you to begin working without requiring you to find and open your database every time you start the program.

If you do not find this feature useful and would rather manually select your database every time, go to the options menu and uncheck "Remember last database". Now, when you start BC, you will be presented with the welcome screen.
Selecting a Person – The Person List

Once a database is open, you can begin entering data. The “Person List” form is shown to the right. If the “Remember Last Database” option is active, this will be the first screen you see when you start the program.

BC uses a combination of first name, last name, and Subject ID to identify an individual. To create a new person, fill in at least one of these three fields. If you are collecting data for a research study where the data needs to be stored anonymously, you can choose to use just the Subject ID. Some practices choose to use first and last name, or an assigned medical record number, or other specified HIPAA compliant method. This information is entered into the Subject ID field.

Make sure that you are consistent. If you have a test for John Doe with a Subject ID of 1234 and a test for John Doe with no Subject ID, BC will treat the two tests as two separate individuals.

The list shows the names and Subject IDs of all of the people who have had tests saved in the database. The fourth column, labeled “Count” shows how many test records have been saved for each person. If no tests have been saved to the database yet, this table will be empty. The sort indicator shows which column is being used to sort the list, and in which direction. To change which column is being used to sort the list or the sort order, click the header of the desired sort column. Click it again to reverse the sort order.

To review someone’s history or to enter a new test for someone already in the database, scroll through the list to find them and either double-click on the person, or single-click to select him/her and click the “Select Person” button.

Most people will start by typing the person’s name and/or ID into the input form, even for people they know are already in the database. As you change the fields in the input form, the list will automatically update to show you only those people who match. In the above example, typing “Al” into the First Name field would reduce the entire list to two people – Al Bernstein and Allison Bednarek. This makes searching the database much easier.

Typing a second ‘A’ into the First Name field (giving “Ala”) would completely empty the list of people. This is perfectly normal, and just means that nobody in the database matches what you have entered. To enter a test for Alan Murphy, finish entering his name and ID (if desired) and either press the Enter key on the keyboard or click the “Select Person” button.

If you select a person who does not already exist in the database, you will be asked if you are sure the ID information was entered correctly, and if you want to create a new person. If so, you will be taken to the Person Identification window. If you have selected someone who is already in your database, you will be taken to that person’s Test List.

Clicking the “Clear Fields” button will reset the input form and repopulate the list with all people in the database.
Searching the Database by Date

At the bottom of the input form on the Person List page is a check box labeled “Test Date.” Checking this box will show only those people in the list who had a test saved on the selected date. The other input fields will continue working as above, further limiting the people to be displayed in the list.

The Person Identification Window

If you tell BC to create a new person, you will be brought to the Person ID window. You can also get there from the test list.

Here, you can verify that the ID information is correct, and select the person's gender and frame size. These two values are here instead of with the rest of the test data because they cannot change from test to test.

Since fat and other tissues are distributed throughout the body differently for men versus women, that affects how the BIA signal interacts with the person's body. As a result, different formulas for males versus females are used to estimate body composition. Note: If at some point in the future, John Doe were to have had a gender reassignment procedure to become a woman, he would need to remain "male" in BC, since genetically, he's still male. Guidance on selecting Frame Size can be found in the Expanded Topics section of this manual.

Because it may be used as a variable in one or more of the equations to estimate body composition, **age** is a required field when entering data for a test. (see the next section) If you choose to store the person’s birth date in the database, their age will be automatically populated on the test data form.

To enter a birth date for a person, you must first mark the “Store Birthdate” check box. Clicking the icon in the right side of the entry field brings up a calendar to simplify entering the birth date.

Entering Test Data

On this screen, you can enter the bulk of the information about the test. At the top is the date and time that the test was performed. If you need to change that, click the change date button, make your changes, and click OK.

Height, weight, age, activity level, and target weight are entered in the box on the left. If any of the “Extra Fields” were selected for entry, there would be additional boxes of input fields on the left. If there are more fields than will fit in the window as it is currently sized, you can scroll the list or re-size the window.

Height can be entered in centimeters, inches, or feet and inches. If you change the height units, the units on the circumference fields (part of the “Extra Fields”) are automatically updated to match. The same is true for weight units and target weight.
If you leave the target weight blank, BC will calculate one for you when you save the test. See the section on “Changing equations” for more information on the target weight calculation. This value has no impact on the body composition estimates. It is purely there for supplemental information.

The activity level selection has no impact on the body composition estimated by BC, and primarily exists for informational purposes. If BC Segmental were estimating Basal Metabolic Rate (BMR), activity level would be used to adjust that value to an estimate of Daily Energy Expenditure (DEE), which is an estimate of how many calories a person’s typical daily routine consumes. Most Americans are going to be considered either "light" or "very light", especially if they spend the bulk of an average day sitting in a chair. For further clarification, please see the Expanded Topics section for Activity Level.

The table for the BIA resistance and reactance data is on the right. Data can be manually entered into the table, but it is easiest to allow the software to retrieve this information directly from the analyzer.

To manually enter data, first select a zone from the empty drop-down menu in the first column. A new empty row will automatically be created when you do. Fill in the resistance and reactance values next to the appropriate zone label.

To retrieve the BIA zone data directly from the analyzer: first make sure that the analyzer is connected to the computer with the USB cable and that the communication settings have been properly configured. See the section titled “Configuring Communications” for more details. Click the “Get BIA Data from Analyzer” button and the dialog box to the right will appear:

If the zone data has already been collected and just needs to be downloaded from the analyzer, select the first option. Otherwise, if the analyzer is connected to the person and the computer simultaneously, selecting the second option will cause the analyzer to begin collecting a new set of BIA zone data and immediately download it. In either case, once the resistance and reactance data has been downloaded, you will be asked if you want to erase it from the analyzer. If you choose not to erase it now, you can go back and erase it later from the “Analyzer” menu.

Below the BIA fields is a box for comments. This is purely optional, but if you have any messages to give the individual, or if there are things about this test that are noteworthy, you can type them in here. If you do fill this in, you can have your comments appear on the printed report.

If the test has not yet been saved to the database, the Delete Test button will be disabled. If you change your mind about saving a new test to the database, you can just click the X button next to the person's name to go back. Otherwise, after asking you to confirm your intent, BC will remove the test from the database and take you to the Test List when you click Delete Test.

To save this test to the database, click the Save Test button. If the Target Weight field was left blank, BC will automatically fill it in using the selected method. If, after saving it, you realize that you need to make a change – say you thought 185 was a more reasonable target weight instead of the 178 that BC came up with – make the necessary change and click Save Test again. BC will warn you that the change cannot be undone.

If the test has been saved to the database, you can see the calculated results by clicking the "Go to Results" button in the lower right.
Test Results

The results screen shows all of the calculated values for the test.

The Results tab shows the person's current estimated body composition data. The history tab will contain the results from all of the tests for this person in the database, side-by-side for easy comparison.

To view, print, or create a PDF report, select the appropriate option from the FILE menu.

The X button next to the person's name will take you back to the test input form.

Creating Reports

If you have a test record open, you can create a report by going to the file menu and selecting either Print Report or Create PDF Report. Print Report will bring up the standard window asking which printer to send the report to. PDF report will open a window asking what to name the report and where to save it.

In either case, the generated report will contain:
• all of the selected charts and graphs,
• the average ranges if they were selected and,
• if they were selected, the Food & Fitness information.

Any item on these three screens that is checked will be added to the report. Any item that is not checked will not appear in the report. If you want a report with no charts or graphs, make sure that all of the charts and graphs are turned off on the results page.

Additional settings for controlling the appearance of the reports can be found in the Report Options window, which is accessed from the Options menu.
The Test List

Closing the test input form will bring you to the test list. You can also get there from the Person List by selecting somebody who already exists in the database.

All of the information that was on the Person ID form is in the upper-left corner. If any of this needs to be changed, click the Edit Identification button and return to the Person ID form.

Below that is a count of how many tests for this person have comments. If comments have been made on any of the person's tests, clicking View Comments will open a new window displaying them in chronological order.

The list of John Doe's saved tests is on the right. If he had more than one test in the database, they would be sorted in reverse-chronological order, or newest first.

To view an existing test, select it from the list and click Open Selected Test. To enter a new test, click “Enter New Test”.

Great caution must be used with the Delete Person button, as it will completely remove the person from the database and erase all of their test records. If you do click this button, BC will ask you for confirmation before proceeding.

Pre-filling Follow-Up Tests

Every time you create a new test for someone, you will need to fill in height, weight, age, resistance, and Reactance. Any change in these parameters will need to be noted accurately in order for the composition assessment results to be accurate.

When you start a follow-up test for someone, if you activate "pre-fill test records" from the options menu, the height, weight, and age will be automatically loaded from the individual’s last test date. This way, instead of asking "how tall are you? how old are you? etc", you can ask "Are you still…."
Changing Equations

BC allows you to create a report so change which equations are being used to estimate the body composition information from the BIA results. To change the equations, either go to the options menu and select "Equations" or, from the test data form, click the “Equation Selection” button.

The equations used by BC to estimate body composition have been collected into groups called “Equation Sets”. The top drop-down menu in this form allows you to choose which set to use. BC Segmental, by default, only comes with one equation set, called “Segmental”. If you had any additional equation sets installed, this is where you would choose between them.

There are also two different options for calculating a default target weight. Regardless of which option is chosen here, the value that is calculated only gets used if you leave the target weight field blank when you save a person's test.

The Hamwi Ideal Weight Equation is based on height and gender. Most agencies that use the Hamwi formula will adjust the calculated value for body frame size. If a person has a "large frame", they add 10% to the result of the Hamwi formula. For a "small frame", they subtract 10%. BC automatically applies this adjustment for you. To see the unadjusted result from the Hamwi formula, select a “medium frame” for the individual. Instructions on how to determine frame size can be found in the Expanded Topics section.

The other option for calculating a default target weight is to essentially use the formula for body mass index, backwards. The BMI formula uses a relationship between height and weight to generate and report a number. The higher the number, the more "overweight" a person is assumed to be, but it does not actually address how fat they are. If somebody is 5-foot 6 inches tall and 235 pounds (167.6cm and 106.6kg) then they have a BMI of 37.9, regardless of whether they are sedentary and over-fat, or a champion bodybuilder. But if we start from the assumption that somebody is already over-fat and needs to lose weight, we can ask the question, "Assuming this person does not get any taller or shorter, how much would they weigh if their BMI was a more generally-accepted value?" By default, if you select this method, a "target BMI" of 23 is used, which is near the top of what is generally accepted as the "normal range", but you can use any value for BMI. Again, the total simple scale weight portion of BMI becomes compartmentalized into the various measures reported by BIA.

Regardless of which method is used, if you do not like the value that was calculated, you can change it to a value you feel is more reasonable and save the updated test.

If you changed any of the equation settings, you can choose to apply those changes to the currently open test. You can also choose to make it the default for that person going forward, or the default for everybody. BC can also go back and change the equation set for all of the previous tests in the database for that particular individual. Since this last option involves changing already completed test records, it will no longer be active, by default. You must manually select it. To commit the equation set change, click OK.
Report Options

The report options window allows you to change various aspects of the generated reports. You can get to it from the Options menu.

The report header will appear at the top of the first page of the report. Most people put the name, address, and contact information for their facility in the header, but it can be any information you choose.

Below that is the report template to use. To browse for available templates, click the drop-down under “Report Template”. By default, BC Segmental only comes with one report template. If you had more templates available, this is where you would be able to choose between them.

The rest of the options control sections within the report layout.

Current test summary will add all the calculated values to a table in the report. Using the plain report template, this table will look exactly like the Current Test Data table on the Test Results screen.

If average ranges are available in your installation of BC, activating Average Ranges will allow the appropriate averages for the tested person to appear in the report.

Clicking on Charts and Graphs will allow you to override the selection of graphs. If it is turned off, no charts or graphs will ever appear in the report, regardless of how many are selected on the Test Results screen.

If you have entered comments for an individual, turning on Comments History will add a section for them to appear on all subsequent reports, as well.

The majority of equations used by BC are published in scientific journals. If you want the bibliographic citations for the equations used to appear at the end of the report, turn on References. For reference, the complete list of citations with full abstracts, or summaries, for all equation sets, is in the back of this user guide.

Activating Definitions will add a brief, 1-2 line description of each value near the end of the report.

In addition to the historical graphs on the results screen, you can also add a table which shows, strictly numerically, how the person has changed over time. If you choose to add a history table, you have two choices.

The Full History Table will list the values for every test in the person's history in columns for easy comparison. If there are more tests than will fit across the page, BC will start a new row.

If you have an individual with an extraordinarily lengthy BIA test series, you can also click on Difference Table, to simplify the report. This feature will not print every single test; instead, it will list out all of the values in the current test, and show you how much of a difference there is between that test and the previous one, and between that test and the individual's very first baseline test.

To make any changes to the report settings permanent, click OK.
"Quick Report" Templates

The normal process for printing a report for a test is to check the Report Options window to make sure that all of the settings have been selected as desired, then going to test results and checking all of the desired charts and graphs, verifying the average ranges option, making the appropriate selections on the Food & Fitness screen, and then finally going to the file menu and selecting either print report or create PDF report.

If you find you are frequently making the same selections every time you create a report, you can streamline the process by using the Quick Reports feature. To create a Quick Report template, make your selections to build your desired report format for a test in the database, as usual. But instead of going to the File menu and generating the report, go to the QuickReports menu and click Save QuickReport. Give it a descriptive name, and click OK.

Now if you go back to the QuickReports menu, you will see two new entries. One would print a report using your new template, and one creates its corresponding PDF format.

Now, if you select a different test, instead of building the report the way you normally would, you can go to QuickReports, select the layout you prefer, and the report will be built automatically.

To delete a QuickReport template, select Delete QuickReport from the menu and then select the template to delete from the drop-down menu, and click OK.
Exporting Data

BC allows you to export all or part of the currently open database as a spreadsheet. While most people will probably never have a use for this functionality, some, including researchers, will find it invaluable.

Go to the Import/Export menu and select Export. If you have a saved test open, you can choose to just export that one test to the spreadsheet. Or you can export all tests for the currently open person, or even the entire database.

Once you have selected how much data to export, the Export Database window will appear. You can export the data to a CSV file or to another BC database.

Select “CSV file” if you want to be able to view the data in a spreadsheet or work with it in a statistical analysis package.

You can copy data from this database into a different one by selecting “BC Database File”.

Once you have selected the type of file to export to, click the Browse button and select the folder and file name for the exported data, and click save. BC will update the location box with the full path information of the destination file you selected. If you were to just type a file name in the location box, BC will place the exported data in your documents folder.

Regardless of whether you are exporting data to a database or to a CSV file, if the destination already exists, the new data will be appended to it.
Configuring Communications

If you have an analyzer with a communications port, before it will work with BC, you will have to tell BC how to talk to it. To do this, go to the Options menu and select Communication Settings.

The first thing to do is to make sure that the "Communicate with Analyzer" box is checked. Turning this box off disables or hides certain controls to simplify the practitioner experience and to keep you from trying to do things that are certain to not work.

The next thing to do is select which port to use. Here are some guidelines to help you choose the right port: If, when you connect your analyzer to your computer, the end of the cable that plugs into the computer has 9 pins, the port you want will probably be listed either as COM1 or COM2, on Windows.

If the analyzer plugs into a USB port on your computer, there is an easy way to find the right one. If the analyzer is currently connected to your computer's USB port, click OK to close the Communication Settings, disconnect the cable from the USB port on the computer (do not just disconnect it from the analyzer) and reopen the Communication Settings.

Click on the Ports drop-down menu and make note of which ports are listed. Because the analyzer cable is not connected, the one you want would not yet be listed.

Now, close the window, connect the cable to both the analyzer and your computer's USB port, and reopen Communication settings. There should be a new entry here – that is the one you want to select.

You also need to set the speed to use. Typically, the speed to choose would be 38400. However, some devices like the Quantum-III might need a slower speed, like 9600. To verify which one you should need, please refer to the manual that came with your BIA body composition analyzer device. Once you have set both the port and speed, click OK.

To easily test the settings, you need to be on the test data screen, so you will need to select or create a random person and tell BC you want to enter a new test. If you have a test open that has already been saved to the database, close it and start a new one so you don't accidentally change it.

For this test to work, the individual cables do not need to be connected to the analyzer, but it does need to be turned on and connected to your computer. Once you think everything is ready, click the Get BIA Data from Analyzer button.

If you get a message about a timeout, it means that there is still a problem to be corrected. Double-check that your analyzer is turned on and still connected to your computer. If it is, change the speed and try again.

If it works and the individual cables are connected to either an individual or the test resistor, numbers will appear in the resistance and Reactance fields. Otherwise, if the individual cables are disconnected, BC will tell you so. This still counts as a successful test of communication, as the BC Software is reporting what your analyzer sees.
Analyzer Maintenance

BC allows you to perform certain maintenance tasks on your analyzer, if communications have been established with it. You can access the list of maintenance tasks from the Analyzer menu. The options are as follows:

1. The Communication Settings menu option is a duplicate of the option found in the Options menu. It takes you to the window described in the “Configuring Communications” section of this guide.

2. If your analyzer supports has an internal clock, selecting Analyzer Time and Date will display a window that will continuously update with the current date and time according to the analyzer. If the analyzer’s clock is incorrect, click the Reset Time button to set it to the current date and time on the computer.

3. If there is data on the analyzer that is no longer necessary, selecting Erase Data from Analyzer will allow you to remove it. If you select this option, you will be asked if you want to remove just the most recently saved test or if you want to remove all tests from the analyzer. Make the appropriate selection and click OK. After confirming that you really wish to proceed, the record or records will be removed from the analyzer.
Expanded Topics

Activity Level

The “Daily Activity Level” describes the amount of physical work associated with the individual’s typical daily routine. The activity level does not affect the body composition estimates, but it is still important to select an activity level that is appropriate to the amount of activity that the person sees on an average day. This is used to help estimate the person’s Daily Energy Expenditure (DEE), or the number of calories the person needs to consume to keep their weight stable. Right-clicking on the Activity Level drop-down will open a new window containing the following descriptions to help choose the most appropriate activity level.

Remember to choose the level that most closely reflects their typical routine. Lists of example activities are also provided for each level. If the listed activities are descriptive of what the person does for most of the day or the description fits, choose that activity level.

BC uses updated names for the activity levels, compared to those found in earlier software versions from RJL Systems. The older names are listed as well, for your reference.

**Very Light (No Exercise)**
A sedentary lifestyle with little to no exercise. Inactive in both work and leisure. **Example activities:** Seated and standing activities, painting, driving, laboratory work, typing, sewing, ironing, cooking, playing cards, playing a musical instrument.

**Light (Some Exercise)**
Intense exercise for at least 20 minutes once or twice per week or the daily routine includes some walking, such as a student. Generally reflects a person who does not exercise regularly, but who maintains a busy lifestyle that requires walking frequently for long periods. **Examples of light intensity activities:** Walking on a level surface at 2.5 to 3 mph (4-4.8 kph), garage work, carpentry, restaurant trades, house-cleaning, child care, golf, sailing, table tennis

**Moderate (Moderate Exercise)**
Intense exercise for at least 20 to 45 minutes 3 to 4 times per week or an occupation that involves a lot of walking or other a moderate intensity activities. **Examples of moderate intensity activities:** Walking 3.5 to 4 mph (5.6-6.5 kph), weeding and hoeing, carrying a load, cycling, skiing, tennis, dancing

**Heavy (Athletic)**
Intense exercise for 60 minutes or greater 5 to 7 days per week. Labor-intensive occupations also qualify for this level, such as construction work (brick laying, carpentry, general labor, etc.), farming, landscaping or similar occupations. **Examples of heavy activities:** Walking with a load uphill, tree felling, heavy manual digging, climbing, competitive basketball, football, or soccer

**Exceptional (Elite Athlete)**
Exceedingly active and/or very demanding activities. Generally, this level of activity is very difficult to achieve. **Examples:** athlete with an almost unstoppable training schedule with multiple training sessions throughout the day or a very physically demanding job, such as shoveling coal or working long hours on an assembly line.
Basal Metabolic Rate

By default, BC will currently estimate BMR based on the person's current estimated FFM. In the past, BMR was calculated using the Harris-Benedict formula by default. To return to using Harris-Benedict, see the Changing Equations section in this manual.

Body Mass Index (BMI)

The formula for calculating Body Mass Index was published in 1832 by a man named Adolphe Quetelet. He had done numerous cross-sectional studies of how humans grow, and observed that aside from the growth spurs after birth and during puberty, “the weight increases as the square of the height.” He noted that, with some variability for people getting fatter or leaner, or more or less muscular, this ratio tends to stay more or less constant for a person as they grow.

The formula for Body Mass Index (BMI)

\[
BMI = \frac{\text{weight (kg)}}{(\text{height (meters)})^2} \quad \text{BMI} = \frac{\text{weight (pounds)}}{(\text{height (inches)})^2} \times 703
\]

in metric \hspace{1cm} \text{in Imperial units}

In the 1960s, an insurance company decided upon a general rule-of-thumb originally called the “Quetelet Index”, to say “This person weighs more than he ought to,” and used that as justification to charge more for their life insurance policy. Later studies revealed problems with the use of BMI as a gauge of fatness. The formula does not take into account body frame size, fluid component variations, muscularity, gender, age, or ethnicity – BMI is strictly a ratio involving height and weight, without regard to the composition of the body. If somebody is 5-foot 6 inches tall and 235 pounds (167.6cm and 106.6kg) then they have a BMI of 37.9 which means they are morbidly obese, regardless of whether they are a sedentary and over fat, or a champion bodybuilder.

For these reasons, the BIA accurately reflect how much fat is in the individual, rather than adding all of the other components of the body to the total weight only used in BMI.

---

Electrodes

Sometimes practitioners will consider utilizing electrodes from other medical devices in their office, or purchasing replacement electrodes from non-RJL vendors.

The electrodes recommended by RJL meet the specifications represented in the published medical research utilizing BIA technology. RJL is committed to optimal performance, and we caution our customers against any practice that may compromise accuracy. While a variety of different electrodes may look the same, the conductive gel varies significantly, i.e. based in tin, silver, silver oxide, or some other medium.

RJL electrodes are regularly tested to deliver the quality and accuracy that you and your patients deserve, guaranteed.

Electronic Medical Implants

Since the manufacturers of implantable electronic medical devices (i.e. pacemakers) do not generally test their products to ensure that they will continue to operate correctly during and after a BIA test, the FDA has requested that RJL caution against the use of a BIA on individuals with those types of devices.

This issue was addressed and summarized in the international ESPEN 2004 statement on BIA in clinical practice, stating while there was a possibility of altered pacemaker or defibrillator activity, and that cardiac activity should be monitored, no interference with pacemakers or defibrillators is anticipated.2

A 2012 article published in Pacing and Clinical Electrophysiology reported no evidence of BIA interference in 20 subjects with implantable cardioverter defibrillators.3

Medical devices vary in specification and function. For your reference, RJL Systems Quantum BIA devices utilize a fixed 50 kHz signal, and conform to the requirements in ANSI/AAMI ES1 and IEC 60601-1:2005, for maximum allowable current applied to the patient.

RJL Systems continues to advise individuals to consult with their physician regarding their particular electronic medical implant device.

Frame Size

There are two generally accepted methods for measuring frame size:

• **The Precise Method** - First, measure the individual's height. Next, use a measuring tape to measure the circumference of the individual's wrist. Be certain to use the same units for both measurements. (Do not mix inches and centimeters.) Divide the height by the wrist circumference. If the result is greater than 10.4, the individual has a small frame. If it is less than 9.6, the individual has a large frame. Otherwise, the individual has a medium frame.

• **The Easy Method** – A simpler, yet less precise, method is to have the individual wrap his or her thumb and forefinger of one hand around the wrist of the other hand. If the thumb and forefinger overlap, the person is said to have a small frame. If the tips of the thumb and forefinger touch, the person has a medium frame. If there is a gap, the person has a large frame.

Pounds vs. Percentages

Review the screen images shown in the Entering Test Data, Test Results, and Average Ranges sections in this manual. The data shown for John Doe is a good example of this situation.

Since John is 234 pounds, he is above the average range for weight of 142-217.

Look at Fat-free mass, in terms of weight. at 150.4 pounds, he is within the average range of 112-157. But if you look at it as a percentage of his total body weight, 64 percent is *below* the average range of 69-81%.

The key is that John is heavier than the average man in his 30s. So, while he may have a typical amount of fat-free mass in his body, since he is heavier, that typical amount actually represents a smaller portion of his body.

To illustrate, imagine two different individuals, each with exactly 20 pounds of body fat. Person A weighs 100 pounds, but person B weighs 120 pounds. Keeping in mind they each have exactly the same amount of body fat, it equals 1/5 of Person A, but 1/6 of person B.

So, when you are comparing a person against someone else, or a reference range, it is probably best to look at the percentages. But when you are comparing that individual’s historical changes over time, it is better to compare the weights of the compartments instead of the percentages.

For example, someone who weighs 200 pounds comes in to get a body composition test done. We find that he's got 20 pounds of fat, but he's also bloated and retaining excess water. A couple weeks later, he comes back to retest, and we find that he has lost 10 pounds of water weight, but still has 20 pounds of fat. He hasn't changed the amount of fat in his body, but he now weighs only 190 pounds instead of 200, so his body fat percentage has gone up slightly.

Re-installation

If you have lost or misplaced the USB thumb drive for the software that came in your kit, you can purchase a new one by contacting RJL Systems through our website, or by calling 1-800-528-4513.
Statistical Analysis

BC Segmental allows you to export your database to a Comma-Separated (CSV) file. Any spreadsheet or statistical analysis package should be able to read files in this format without any problems. For more information, see Exporting Data.

Calculating a Target Weight

On the individual input form, you can choose to either enter in your own value for target weight, or you can allow the software to calculate one for you. If the software calculates it, it will use one of two formulas:

Hamwi Ideal Weight Equation

By default, the formulas that the software uses to calculate target weight are called the “Hamwi Ideal Weight Equations” which are as follows:

• **For Males**
  Target weight = 106 + [6 x ((height in inches) - 60)]

• **For Females**
  Target weight = 100 + [ 5 x ((height in inches) - 60)]

As you can see, the Hamwi Ideal Weight Equation is strictly based on height and gender. Most agencies that use the Hamwi formula will adjust the calculated value for body frame size. If a person has a "large frame", they add 10% to the result of the Hamwi formula. For a "small frame", they subtract 10%. BC automatically applies this adjustment for you.

To see the unadjusted result from the Hamwi formula, select a “medium frame” for the individual. Instructions on how to determine frame size can be found in the Expanded Topics section.

Target Weight Based on Target BMI

BC also has the ability to calculate target weight based on a “desired” BMI. Using this method, the program answers the question, “How much would this person weigh if they changed their weight so their BMI was XX?” In this way, you can specify your own “desired BMI”. The program will normally use a BMI of 23, which is the border between “normal” and “overweight” using BMI.

The way BMI is typically used – as an indicator of “fatness” - it is pretty universally considered to be a poor tool. But if we start from the assumption that somebody is already over-fat and needs to lose weight, we can ask the question, "Assuming this person does not get any taller or shorter, how much would they weigh if their BMI was a more generally-accepted value?" In this way, we can use it to generate a ballpark target for that person's weight loss goals.
Glossary of Terms

The terms below, as well as the graphical representation at the right, will help describe the general breakdown of the composition of the body.

**Height** – in inches (in) or centimeters (cm)

**Weight** – in pounds (lbs) or kilograms (kg)

**Resistance** – the opposition to the flow of an electrical current. Higher TBW and LDM yield a lower Resistance, and higher Fat and dehydration yield a higher Resistance.

**Reactance** – measures the body's opposition to changes in the flow of an electrical current. Reactance is related to the capacitance of the cell membranes, and reflects integrity, function, and composition.

**Phase Angle (PA)** – PA reflects the relative contributions of fluid (resistance), and cellular membranes (capacitive reactive). It is calculated as the arc-tangent of Reactance over resistance, measured in degrees. Typical Phase Angles (NHANES human data) range between 4-9.

**Fat** – provides insulation, warmth, and energy storage, and is necessary for the absorption of many vitamins.

**Fat Free Mass (FFM)** – is also called Lean Body Mass, and is everything in your body, except Fat.

**Lean Dry Mass (LDM)** – is what is left after subtracting all of the water from your Fat Free Mass.

**Total Body Water (TBW)** – is all of the water through- out your body, both inside and outside of your cells.

**Intra-Cellular Water (ICW)** – represents the amount of water inside your cells.

**Extra-Cellular Water (ECW)** – represents the amount of water outside of your cells.

**Bone Mineral Content (BMC)** – Bones are dynamic organs that include cells, blood vessels, collagen and mineral deposits. BMC is only an estimate of the minerals in the bones and does not represent the total weight of the skeleton. It is part of Fat-Free Mass.

**Lean Soft Tissue (LST)** – In the same way that LDM is the result of removing all water from Fat-Free Mass, Lean Soft Tissue is the result of subtracting Bone Mineral Content from Fat-Free mass. This includes your organs, muscles, connective and supportive tissues, as well as all of Total Body Water.

**Skeletal Muscle Mass (SMM)** – SMM are the muscles responsible for posture and movement.

**Basal Metabolic Rate (BMR)** – The caloric energy required to sustain life in a sedentary state for 24 hours.

**Daily Energy Expenditure (DEE)** – DEE adjusts the BMR valued based on the selected activity level. The caloric energy required to sustain life, plus daily activities.

**Body Mass Index (BMI)** – BMI is derived by diving total weight (kg) by height (m), squared. BMI is a general measure typically used to determine if someone is overweight, but knowing actual body composition is much more accurate.

**Fat Mass Index (FMI)** – FMI relates fat mass to height in the same way that BMI relates total weight to height. Because it takes into account only the fat mass, it is a superior indicator of obesity compared to BMI.

**Fat Free Mass Index (FFMI)** – FFMI relates fat-free mass to height in the same way that FMI does to fat. Fat+ FFM – Weight, FMI +FFMI = BMI.